How to use the AncestryDNA Helper extension for Chrome
Documentation version – updated as of August 5, 2017:
The latest notes will be on the website page – http://www.itstime.com/AncestryDNAHelper.htm. The most current version of
the extension will be found in the Chrome store. This documentation is only updated as necessary.

New: Simple instructions for those who are just learning about DNA:


Rob Warthen - Ancestry DNA Helper http://www.dnanewbie.com/third-party-tools/ancestry-dna-helper/



Shannon Christmas - Using AncestryDNA: Steps for Success
http://throughthetreesblog.tumblr.com/post/69923962243/using-ancestrydna-steps-for-success

==========================================================================
What the AncestryDNA Helper extension does
The extension allows you to download a file of all your AncestryDNA matches and their ancestors into a csv file, which can
be used in Excel or any program that can read text files.
The search function allows you to search for matches by user name and see if they match multiple tests. You can also
compare 2 or 3 tests to see common matches. And, much more....

More about how the AncestryDNA Helper works
The extension identifies matches by the combination of the unique testid for each test and the matchids, which are unique
relative a particular test, but I don’t know if they are globally unique. The scanner technically runs all the time gathering data
from the matches list and details pages every time they are opened.
The scan buttons have two phases:
1.

First, it simulates a user clicking through all of the pages of the matches list and trashed matches list for one or more
tests, depending on which button you clicked; and

2.

Second, it views each match details page that it hasn’t marked as scanned yet one by one, so that you don’t have to do it
yourself.
The “Resume Scan” button skips directly to the 2 nd phase.

The current version of the AncestryDNA Helper can be found in the Chrome store.
If you would like to save your database from an earlier scan, read the instructions below before starting a new full scan.
We suggest reading through all the instructions before you do a full scan.
Note that when starting a new full scan or restarting a scan, your browser may not give any indication that the scan is
running for several minutes. Check the Chrome database folder on your hard drive to see if it is making changes in the
files there to be sure it is running.
Older versions of the extension won’t work because Ancestry.com changes the structure of their website periodically. Also,
once you install, you need to either refresh any AncestryDNA pages that were already open or restart Chrome, which has the
same effect.
You can download the current release of the Chrome extension by going to the Chrome store and searching for the
“AncestryDNA helper” add-on.
If you do not already have the Chrome browser installed, you can get it here:
https://www.google.com/intl/en/chrome/browser/. If you have a 64-bit computer, it is advised to get the 64-bit version of
Chrome https://www.google.com/chrome/browser/beta.html.

How to Install the Extension:
1) Open the Chrome browser, and click on the little icon in the upper right corner with 3 horizontal bars.
2) You have to be signed onto a Google or Gmail account to add extensions. (If you don’t have a Google or Gmail account,
they are easy to create at Google.com or Gmail.com)
3) Scroll down to Settings and click that link.
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4) On the left side, select Extensions. At the top right of the screen, check the box “Developer mode.”
5) At the bottom of the screen, select “Get more extensions.”
6) Search for AncestryDNA Helper and select “Free” button. You have to be signed onto a Google or Gmail account to
install it.
7) Once the extension installs, close the Chrome browser and reopen it.
Note: there are reports that the extension does not play well with Incognito Mode, which disables all extensions by default.

Running the AncestryDNA Helper extension the first time:
Once the extension is installed, you should go to “Your DNA Home Page” at http://dna.ancestry.com/#/tests and click on the
“Scan” button to automatically scan all of your matches so that the extension can then help you search, compare or download
that data. The full scan process can take a while to complete – much less than before Ancestry revised their formulas with
version 3 of the test results.
The speed of a scan is highly dependent on the number of matches you have, the speed of your computer, the speed of your
Internet connection and the activity going on with the Ancestry.com website at the time. The faster your computer and
Internet speeds, the faster your scan will be.
NOTE: The extension may seem to do nothing when first started, so walk away and give it time to do what it needs to do to
get started. There is a lot going on behind the scenes as it starts the scan.

Scanning Speed examples: In early November 2014, a full scan of 3 tests on my computer took more than 3 full days to scan
running almost constantly. My 3 tests have colonial New England and/or colonial Virginia ancestors with 16,000+ matches
on each test. My computer is Windows 7 Pro, i5-2500K @ 3.3 GHz, 16 GB memory, 50+ Mbps wired Internet download
speed connection. Users with slower computers and/or slower Internet connections can expect longer scan times.
After the revised AncestryDNA (v2) released late November 2014, the same full scan took about 2 hours for the same 3 tests.
At that time, the 3 tests I managed had counts of 1,942 and 4,173 and 2,716 matches compared to more than 17,000 each just
before the redesign.
Once the extension starts scanning, it will open a new tab in the Chrome browser for each match, so you will see flashing or
find it difficult to use the browser or anything else on the computer for other things. It is best to leave it running for however
long it takes. This feature was implemented due to earlier versions that were blocked by memory issues in Chrome.
While scanning, the AncestryDNA web pages might error out or hang occasionally. The extension makes every attempt to
auto-refresh and these time-outs are far less frequent then they used to be.
If the scan fails to automatically refresh and appears to be stuck for several minutes, you will need to press the F5 key or
click the Reload button to get it started again. You can Cancel and restart the scan at any time with no loss of data.
If you get the Chrome “Aw, Snap” screen, click Reload, then go to your DNA home page and click the Resume Scan
button.

AncestryDNA Helper Add-on for Chrome (by Jeff Snavely) — How to Use http://www.itstime.com/AncestryDNAHelper.htm

Page 2 of 12

Example of top of Chrome window on the Ancestry DNA Home Page:

You need to visit your DNA Home Page for each test before clicking the Scan button to get it to scan all of your tests.
Note: After downloading a .csv file, sometimes, you may need to refresh the page before you can download another. Files
will be sent to the default “Download” folder on your computer. In Windows 7, this is usually
C:\Users\ComputerName\Downloads.

Stop and Restart
You can stop the scan at any time by clicking the Cancel button while it is scanning pages. If you do stop the scan or close
the browser before it completes the scan, you can resume by going back to “Your DNA Home Page” and clicking the
“Resume Scan” button. [There are no longer separate Resume Summary Scan or Resume Detail Scan buttons.]
If the extension was still scanning match summary and trashed match summary pages when you stopped the scan, it should
restart the scan from the first page of matches for that test. If you stop the scan while it is scanning match details pages, it
will resume with the next match details page not processed yet.
If you already have the matches and want to resume the ancestors scan, click the “Resume Scan” button.

Adding New Matches to the Database
To add new matches to the database as they show up after you have already done a full scan, simply view the first few pages
of the matches list (depending on how many new matches you have) for each test while sorted by Date and then go to your
“DNA Home Page” and click the “Resume Scan” button to have it automatically open all of those new matches. This will be
much faster than doing the full scan again.
You can do a full scan of just one test that you administer (or tests shared with you) by using the Scan button on that test’s
page.
After you have scanned your matches, you can use the Search box at the top of your match list pages to look up your
matches by Ancestry User Name or look up all matches with the same Surnames or look up all matches based on the Notes
that you have recorded in the note field on your matches.
If you administer multiple tests on your account, you will find a new pink and blue heads icon on the list of matches
indicating those that are shared with other tests that you administer. Holding your mouse over this icon will show the names
of the tests that share this match.
You will also find buttons on your DNA Home Page for downloading your list of matches and ancestors of matches as .csv
files, which can be imported into a spreadsheet or database program for further analysis. These files will normally go to your
default Downloads folder.
If you have newer versions of Excel installed, Excel may try to open these .csv files when you download them.
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Adding New Fields to your existing Database
If you have an old database from before version 0.7.11, you can update the new fields in your existing database (matching
cMs and segments) by using the View Match to open to the tree view. That will automatically update the new fields for you
and they will be available next time you download your match file.

Retry Skipped Matches
A new feature was implemented with version 0.7.1 – the button Retry Skipped Matches. Sometimes, the extension will
skip matches that it should have scanned. This button will let you try again.
The Match file for each test contains a date stamp of each ancestor file scanned. If a test seems not to have scanned, check
the dates in the field called “scanned” to make sure it is filled.
Example of “scanned” field of the Match file:

Other Features:
Compare two tests
From your AncestryDNA Home page or from any individual test page, you can compare any two tests that you
administer (or tests that have been shared with you) for common ancestors or compare up to 3 tests against each other
(typically a child and their parents, or you can enter any 3 tests administered or shared by your account) to determine
which side (or both or neither) that the match came from along with predicted range and confidence info. Using this
option gives a list of User-Ids who match both tests — listed below this section, with clickable links for Test A and Test
B to the tests themselves.
Example of Common Matches:

On your list of test matches, tests in common will have a pink and blue icon that looks like little heads.
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If you hover your mouse over the pink & blue heads icon, it will display the name(s) of other test(s) that match this
person. It only compares tests that you administer or that have been shared with you.
The green leaf in the example above shows that both tests have the same person in their tree. Ancestry gives this as a
hint for possible research. The DNA test itself is NOT based on any information in family trees.
Compare three people – Father, Mother, Child
You can phase a child’s test based on one or both parents. This option gives a downloadable .csv file with details about
the test for the child and both parents. You can run this match for any 3 people (detailed instructions below). The
phased CSV file contains all the matches for all 3 people selected.
Example of Phased Matches for parents/child.

Example of output file for phased tests:

Compare Any 3 tests to find common matches
This a very handy feature for comparing the results of multiple tests you mange or that have been shared with you.
1.

Use the Phase option as mentioned above for parents/child. Instead of selecting parents/child, select any three tests
that you want to compare.

2.

I use Excel 2000, so open the downloaded phased CSV file in Excel and rename the fields — replace “Father” with
the 1st person in the comparison, replace “Mother” with the name of the 2 nd person and replace “Child” with the
name of the 3rd person.

3.

Click anywhere in the spreadsheet. Go to the Data Menu and select Filters, then AutoFilter. Example:

4.

AutoFilter creates filters for each field in the file. Other version of Excel use slightly different ways to set filters.

5.

Select the down arrow on each of the 3 Range fields and select “Non Blank.” That gives a list of only those tests
that match all three people. You can choose other options - like only select a specific level of the match, etc.

6.

Save your file in Excel if you want to use it again later.
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7.

The CSV file contains all the matches for all 3 people selected.

Download matches
You can download a file of matches for each test.
Sample of .csv file of Matches:

New fields added with version 0.7.11: total cMs and number of segments.
Download ancestors of matches
As of version 0.7.13, this option is no longer available on the DNA home page to download all ancestors. It has not
worked for a long time. The option is still available on each individual match page.
Download ancestors of matches – individual person
You can download the ancestors of a single person’s ancestors with a button below the list of a person’s surnames.

The file will be in .CSV format.
Sample of .csv file of Individual Ancestors for this person:

Metphone and Incidence
About the Metaphone and Incidence columns of the Ancestry Matches spreadsheet:
Metaphone is a standard way to make names that sound alike to be the same. Incidence is the number of times that was
seen.
The Metaphone values are used by the search feature to find names that sound alike.
The testid and matchid columns are used internally by the extension along with the combination of the name and admin
by fields to identify the specific test and match (relative to this test).
The Incidence Score is the number of times the exact same name with a similar birth year from different DNA matches
occurs in this ancestors list. Jeff finds this to be one of the most useful columns in the entire file as it can be used to
discover clusters of matches who all share the same common ancestors. Maybe you link up to those people somewhere
in that same family, or maybe it is just a coincidence.
Search for specific surname
On the individual DNA Results pages, you can search for a specific surname. This option shows on the individual test
results page:
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Sample of Search for Users, Surnames or Notes:

Cost / Donation
There is no charge for this extension. If you would like to make a contribution to say thanks and to encourage further
development, the easiest way to do that is to use the Send Money feature in PayPal to send a “family or friend” payment to
Jeff’s email address: jsnavely@cox.net. Donations are very much appreciated.

Support
One user of the AncestryDNA Chrome Extension has created a discussion list for those who would like to discuss the
technical/scientific aspects of DNA genealogy at Ancestry, including discussion of the extension at:
http://tech.groups.yahoo.com/group/AncestryDNA_Discussion/
You can subscribe by sending an email to AncestryDNA_Discussion-subscribe@yahoogroups.com
Let Jeff know if you have any problems using the extension or any ideas you might have for future enhancements.
*******************

Additional Resources
Alternative Method for Downloading the Ancestor files (February 22, 2016):
If Ancestors of all matches are really needed, there is an alternative process available to download files from Ancestry
and 23andme at https://www.dnagedcom.com/doc/welcome-to-the-dnagedcom-client/. There is a charge for this service
($5.00 per month or $50 for a year)
Using the SQLIte add-on for Firefox using the AncestryDNA Helper database (updated Jan 4, 2017):
Beth Richards has written a couple of blog posts with step-by-step instructions for installing and using the SQLite addon for the Firefox browser to query the database created by the AncestryDNA Helper. See
https://dnahelpersql.blogspot.com/https://dnahelpersql.blogspot.com/https://dnahelpersql.blogspot.com/htt

ps://dnahelpersql.blogspot.com/https://dnahelpersql.blogspot.com/
Using SQLLite and Excel to access files created by the extension (posted by Chris Smith, 4/28/2015 on the Yahoo list):
1.

Go to http://www.ch-werner.de/sqliteodbc/

2.

Download the latest “Current” version for your OS/architecture. Just run and install.

3.

It should create an ODBC DSN titled something like “sqlite3.” To verify, open “odbcad32.exe” and check under
your System DSN tab. You should see 3 entries with the word “sqlite” in their titles. I found I had to download the
non-64 bit driver to work with my 32 bit Microsoft Office installation. It can’t hurt to install both. I did and
everything works fine.

4.

Next, open up Excel and go to “Data->From Other Data Sources->From Data Connection Wizard.”

5.

Once that’s open, chose “ODBC DSN” and click “Next.”

6.

Choose “SQLite3 Datasource” and click “Next.”

7.

Click “Browse” next to “Database Name” and point it to the database file for the extension under
C:\Users\<yourname>\AppData\Local\Google\Chrome\User Data\Default\databases\chromeextension_hjflmfphflaeehhpdiggobllgffelfee_0

8.

There should only be one file there. If there are two files, your scan is either running or something odd happened
the last time you ran your scan.

9.

Keep all of the default settings and click “OK.”
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10. When the “Select Database and Table” window pops up, in the list of table names, scroll down to “ancestors” and
click “Finish” and then “Finish” again at the next screen (unless you have a need to change that data).
How to connect an ODBC datasource from Apache OpenOffice 3, LibreOffice 3 and OpenOffice.org .2.0 — from
http://www.easysoft.com/applications/openoffice_org/odbc.html (I was not able to get this to work myself).
1.

Choose File > New > Database.

2.

Click Connect to an existing database.

3.

Click ODBC in the list, and then click Next.

4.

Click Browse, double-click your data source, and then click Next.

5.

If your database requires a database user name, type it in the User name box. If this user needs to supply a
password, click the “Password required” check box.

6.

Click Finish.

7.

Save the database when prompted. The database opens in a new Base window. From here, you can access your
data.

8.

In the left pane of the database window, click the Tables icon to see a hierarchy of tables. Type the database
password if prompted, and then click OK.

9.

To retrieve the data in a table, in the Tables pane, double-click a table.

10. Click the Queries icon to create a query. Use any of the methods listed in the Tasks pane to create a query.
[Lots more information is on that page about how to use ODBC sources.]
Additional Resource: see later in this document for step-by-step instructions for using the SQLite add-on for the Firefox
browser by Elizabeth Richards (Nov 24, 2016).

Trouble-shooting Tips:
WARNING: Clearing the cache on the Chrome browser will delete your database and you will have to Scan all of your
test(s) again. Uninstalling and reinstalling the extension will also delete your database and you will need to do a full scan.
1.

If the message “Oops, some data isn’t loading” at the top of the screen and/or “Feature unavailable” below the person’s
name, and a refresh doesn’t clear it, WAIT a while (up to 5 minutes). Often, it will clear itself and move on.

2.

Alternative: If it doesn’t clear by itself, Cancel the scan and Refresh the person manually (F5) until the person displays
properly. Then, restart the scan. It should continue the scan, though sometimes, it needs to be refreshed manually again.

3.

If the buttons for the extension don’t show up on the DNA Home Page, try these tips:
 Refresh the screen (F5).

4.



Turn off or disable all other extensions.



Turn off pop-up blockers or ad blockers.



Close the browser and restart Chrome.

Clear ONLY Ancestry cookies.
Sometimes, Ancestry cookies seem to get corrupted, especially after format changes.
If you remove cookies, things like saved preferences for websites might get deleted and you may have to sign in
again. To clear only specific cookies:
1. Open Google Chrome.
2.
3.
4.
5.

At the top right of the screen, click the icon
, then click Settings.
At the bottom, click Show advanced settings.
In the “Privacy” section, click Content settings.
Under “Cookies,” click All cookies and site data.
o To delete a specific cookie or cookies from only one site, enter Ancestry in the search box, then to

o

the right of those listed, click Close
each one to be deleted. We suggest deleting anything with
Ancestry in the name. The cookies will be recreated as needed.
To delete all cookies, click Remove all.
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5.

More drastic steps:
 Delete and reinstall the extension, making sure it is the latest version from the Chrome store. NOTE:
Reinstalling the extension will delete your database, so a full Scan will be needed unless you manually save
and restore your scan database.
 DO NOT CLEAR YOUR CACHE or it will also clear (delete) your DNA database.

6.

Sometimes, the extension gets into a state where it doesn’t recognize manually going from one page to another, which
can usually be fixed by refreshing the page (F5).

7.

If the extension is running but the scan and download buttons do not appear on Your DNA Home Page, then maybe that
not all of your tests have expanded, which is necessary for the extension to get the IDs. Expand any kits that didn’t
expand and the buttons should appear.

8.

If you need to clear out your database and restart, DELETE the file at
C:\Users\COMPUTER_NAME\AppData\Local\Google\Chrome\User Data\Default\databases\chromeextension_hjflmfphflaeehhpdiggobllgffelfee_0\nn (or whatever the folder is called on your system). You can check to
make sure in the Chrome Browser, under Settings with Developer Mode check. Under the AncestryDNA Helper
extension is the ID # matching the folder name of your file above (e.g: hjflmfphflaeehhpdiggobllgffelfee)

9.

As of version 0.7.13, download all Ancestors is no longer an option. Very large Ancestor of Match files will not
download. It seems that when your number of matches gets to around 16,000 (in AncestryDNA v1), the ancestor files
would no longer download. The extension may do nothing at all when you click the Download Ancestors of
Matches button or the extension may crash. This seems to be a limitation in the Chrome browser. One alternative —
using sqlite to access the database — has been suggested on the AncestryDNA Helper Yahoo group https://groups.yahoo.com/neo/groups/AncestryDNA_Discussion/ (instructions follow below).

10. As of mid-April 2015: Ancestor of Match files will not download and Surname searches take a very long time.
Starting in mid April 2015, something changed in the Chrome browser itself so that the Ancestor of Matches file will not
download or will take up to 48 hours to download. Also, surname searches take an extremely long time to complete
(many hours). Both of these use SQL Lite functions within the browser itself. Jeff Snavely has said that he is unable to
fix these issues unless he reprograms a different type of database; he has not given any clues that he intends to do that.
11. Slow Processing and/or Slow Start-up of the AncestryDNA extension. Since mid-April 2015, processing of the
AncestryDNA Helper seems to take a while to “settle” in before it is useable. Suggestion: Open Chrome and your DNA
pages, then let it sit a while (10 minutes or so). I don’t know if this is due to the fact that I now manage 6 tests with a
large database, or whether it is happening to everyone. Queries to the Yahoo list seem to indicate that others who are
impatient are complaining that the extension “doesn’t seem to work” or “doesn’t do anything” when they click the
buttons. I’m guessing that the lag time is due to the same issue as above – a change in the way Chrome is processing
SQL Lite instructions that update the database behind the scenes.. Again, this is my own guess, not confirmed by
anyone else.
Update: Jan 22, 2017: Workaround for the same name showing on the pink/blue heads for multiple tests (from the
Yahoo support group):
1.

Go to your own DNA Home Page.

2.

Select the first DNA test you manage and go to that kit's DNA Home Page. Then, go to the first page of the list of
matches (page number 1 should show in the upper right corner). Press F5 to refresh the page.

3.

Go back to your own main DNA page, select another test, open the first page of matches for that kit and press F5 to
refresh the page.

4.

Keep doing that on each test that you manage or that is shared with you and it should reset the names so they show
properly.

5.

Several people report that fixed the problem.

Explanation about why this happens: Apparently, the pointers sometimes get messed up. If you see a name duplicated
on the list of tests your own home page, go through them one by one in the order they are shown.

Updates and Release Notes:
UPDATES — 3/23/2014 from Jeff Snavely – How to Save, Copy and Restore Your Database:
When changing from the manually installed version of the extension to the Chrome store version, you MUST either
COPY the database to the new location or RE-SCAN all tests.
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Database location on the hard drive – My manually installed database version is here:
On my Windows 7 Pro computer, the old manual version of the extension is here:
C:\Users\COMPUTER_NAME\AppData\Local\Google\Chrome\User Data\Default\databases\chromeextension_ghaaejhfplokgdjeggdoddebifacogmc_0
The new Chrome store version is here:
C:\Users\COMPUTER_NAME\AppData\Local\Google\Chrome\User Data\Default\databases\chromeextension_hjflmfphflaeehhpdiggobllgffelfee_0
More detailed info from the [AncestryDNA_Discussion] list 3/22/2014 8:55 PM:
Since the copy from the Chrome app store is a new install rather than an update to the existing copy, it will create a new
database for that copy. You will need to either close Chrome and copy your existing database to the new location or, if that
seems too complicated, you can do a full scan. Instructions for copying your database file are below:
Chrome hides its databases. The base locations (%USERNAME% is your Windows username) are:
Windows Vista or later:
C:\Users\%USERNAME%\AppData\Local\Google\Chrome\User Data\Default\databases
Windows XP:
C:\Documents and Settings\%USERNAME%\Application Support\Google\Chrome\Default\databases
Mac OS X:
~/Library/Application Support/Google/Chrome/
Linux:
~/.config/google-chrome/Default/databases
Inside that directory will be a sub-directory for each extension using a SQLite Database. The format will be “chromeextension_%ID%_0” where %ID% is the unique id an extension. To find the ids of the extensions, go to chrome://extensions
and check the “Developer mode” checkbox at the top of the screen. The ids will then appear beside each extension. If
Chrome is running, it will lock the database files preventing you from accessing them, so you have to make sure Chrome is
closed, then go into the sub-directory for the old copy of the extension, copy the file that appears there, then go to the subdirectory for the new copy of the extension and paste the file.
If the filename (a number) in the new copy is different, then you will need to delete that file and rename the file that
you just pasted from the old copy to the same name as that other file. When you restart Chrome, it should now use
the existing data instead of an empty file.
Chrome will automatically delete the old database files when you remove the old extension, so you will want to leave it
installed but disabled long enough to transfer the files. If you have already removed the old extension, check your trash
folder for the database file and restore it.
Some Mac users reported having problems locating the database file. Here is some additional instructions that I found for
finding it:
The default locations of Chrome’s profile directory on Windows 7 are defined at http://www.chromium.org/userexperience/user-data-directory.
For Chrome on Mac, the default location is:
~/Library/Application Support/Google/Chrome/Default
The actual location can be different, by setting the --user-data-dir=path/to/directory flag – See
http://www.chromium.org/user-experience/user-data-directory#TOC-Running-from-a-Custom-Location
If only one user is registered in Chrome, look in the Default/Extensions subdirectory. Otherwise, look in the <profile user
name>/Extensions directory.
If that didn’t help, you can always do a custom search.
1.

Go to chrome://extensions/ and find out the ID of an extension (32 lowercase letters) (if not done already, activate
“Developer mode” first).

2.

Open the terminal, cd to the directory which is most likely a parent of your Chrome profile (if unsure, try ~ then /).

3.

Run find . -type d -iname “<EXTENSION ID HERE>,” for example:
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find . -type d -iname jifpbeccnghkjeaalbbjmodiffmgedin
Update: 4/6/2014 from Jeff Snavely:
Note: If you are browsing the match summary pages for a test, be sure to go back to page 1 before initiating a new Scan or it
will likely start at that page instead of page 1. There is no longer an easy way to force it to restart at page 1 now that the page
field is no longer recognized when specified in the query strings.
This could also come in useful in the event that you have to cancel scanning the pages and would like to resume at the
summary page where it left off instead of starting over on page 1.
Updates 5/26/2014 from Jeff Snavely:
I have posted an update that fixes a problem with bad matches getting stuck trying to reload forever. It also adds scanning of
the member since, ethnic regions and ethnic trace regions fields for each match and the scanner now stores the last viewed
page number for each test.
The Scan buttons will still start over on page 1 of the matches list for the appropriate tests.
Once all of the summary pages have been scanned, it will automatically switch over to scanning the individual matches.
The “Resume Scan” button will go directly to scanning individual matches skipping over any match list pages that haven’t
been scanned yet.
P.S. I’m still getting a lot of random “Oops. It looks like some data isn’t loading. Some things may be missing on the page
below. Try again in a few minutes.” messages with pieces of the page failing to load and showing as “Feature unavailable.”
The above mentioned bad matches had this message with both the top and bottom portion of the screen failing to load no
matter how many times I tried to reload. The remaining error messages fix themselves by reloading the page. If you see that
message at the top of the screen while scanning individual matches with the top portion of the screen filled in, but no
pedigree chart, you can press the F5 button to make the page refresh.
Updates 12/25/2014 from Jeff Snavely – about version 0.7.0:
Question: I tried running a scan and rebooted and tried again. It gets hung up on “Sorry, this match no longer exists.” I’m
glad a new update was released to work with Ancestry’s update. I just need to know how to clear out the old info out so it
stops looking for matches Ancestry dropped.
Answer: It’s supposed to skip right past those. You might try refreshing the page to see if it helps. One of the reason it took
so long to get it out was because it was getting stuck on those, but I have it running a scan right now and am watching it skip
past dozens of those MatchGone pages almost as quickly as it can display the page interspersed with a non-purged match
every few pages. Even so, you might want to reset the database and do a fresh scan so that it doesn’t have to spend any time
trying to open thousands of matches that no longer exist. I completely reworked the page change detection in the new
version of the extension to eliminate a lot of redundant code and better handle unrecognized pages to keep it from getting
confused and ending up stuck in the wrong state, but if it does get stuck in another state, refreshing the page should restart it.
Updates 12/29/2014 from Jeff Snavely – about version 0.7.1:
New button: Retry Skipped Matches: If you have started with a clean database after the purge (when Ancestry went
from v1 to v2 in November 2014), you shouldn’t have any skips. However, the next release will have a Retry option that will
allow you to rescan any matches marked as skipped. I’ve also fixed a few more bugs including one anomaly where the
matchGone page will sometimes redirect back to Your DNA Home Page causing the scanner to stop prematurely. That was
driving me crazy for a while trying to figure out why Resume was looking at one or two pages and stopping with a lot of
unscanned matches remaining.
Update 5/30/205 from Jeff Snavely — about the Scanning process
The details scanner doesn’t care which kit was active when you started the scan. It just opens matches in a random order
(probably the order they were first seen). This portion of the scan is only necessary if you want to perform surname
searches or download the Ancestors of Matches report.
If you are not interested in those features, you can stop the scan any time after the match list pages have finished
scanning.
Update 7/6/2016 — about the Scanning process (added by Barbara Taylor):
The second phase of the scanning process fills in additional fields that are not picked up in the first phase. Those
additional fields are: People in Tree (if available), Image URL, Profile URL, Tree URL, Scanned Date, Member Since,
Ethnic Regions, Ethnic Trace Regions.
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If you have not run the full second phase of the scanning process, some records (not all records) in the downloaded
Phased CSV file may be shifted one column to the left. They are at the beginning of the file so it is easy to shift them
over to the right.
November 4, 2016 – Fixes due to Ancestry Changes, Updates and Enhancements
From Jeff: It should be working again once the Chrome updates the users to the latest build. The URLs was the biggest
problem, though I also had to adjust a couple fields on the match list scanner. It should also work for several non-US
versions of the ancestry.com site now (assuming they use the same URL structure under each domain; file downloads are
hard coded to generate URLs using the US version of the domain) and I implemented scanning of the total cMs and
segment count information on the match details pages.
Sources & Copyright: This document is based on information from Jeff Snavely and others, edited and updated periodically
by Barbara Taylor. Examples added by Barbara Taylor. This “How To” file may be downloaded from
http://www.itstime.com/AncestryDNAHelper.htm and may be freely shared for personal use as long as the file stays in tact.
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